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Objective 
 
This class will teach the basics of how a digital camera works so 
an informed decision can be made when buying a camera. This 
includes learning to download your photos to the computer, 
printing and e-mailing the photos 
 
 
 
Class Overview 
 
The Basics Saving a File
Resolution of the photos Working with Images
Downloading Images E-Mail
Resizing Images Sharing Your Photos
Photoshop Elements Library Material

 
 
 
 



 
 

Buying a Digital Camera 
 

Film vs. Digital 
 
 
 
 
 
 
 
 
 
The Basics 
 
This class will teach you the basics of how digital cameras operate so you can make an 
informed decision about the purchase of the right digital camera for you. To do that, we 
will not only teach you about the basics of using a digital camera but also how to 
download your photos to a computer, getting them printed and emailing them to friends 
and family.  During class we will be using Photoshop Elements 4, and digital editing 
software to show examples of images, resizing, and naming photo files.  
 
 

 
Pixels 
A pixel is a tiny square of color, thousands of which make 
up your photo, much like a mosaic. A mega pixel is the 
term for one million pixels. Digital 
cameras are referred to according to the 
maximum number of magapixels they are 
capable of taking in a single photo file. 
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dpi is the term for dots per inch, referring 
to how many dots or pixels per inch you 
have in a digital file. Your printer has a 
specific number of dots per inch it can 
print. It is also used to describe the 
resolution of your computer screen and 
the preview screen on the back of your camera. 



Basic Shooting or exposure Modes – All cameras 
come with options for choosing the correct exposure for 
your photos. These exposure or shooting modes are 
chosen by selecting them on a dial on the top or back of 
your camera. You chose the type of mode you want by 
turning the dial to the icon or letter representing that mode.   
 

Cameras have a standard mode with auto focus so you simply point the camera at the 
subject and press the shutter button.  In the example of a camera above, you would 
choose AUTO. Cameras with more features may also give you the option of setting your 
camera’s ISO and shutter speed manually too. 
 
Digital cameras typically come with these basic shooting modes:  
 

• landscape mode – This mode should be 
selected for a horizontal photo with overall focus 

• portrait mode – Choose this mode for a vertical 
photo with focus on the closest object 

• sports or action mode - This mode is great for 
athletic competitions, kids playing, etc. 

• macro mode – This mode is used for close-ups 
within about two feet or less, depending upon the 
camera’s capabilities. 

 
Special shooting modes 
There are cameras on the market which can give you many more shooting options in 
addition to those listed above. You need to think about the kind of photos you want to 
take and how much money you want to spend on a camera. The more options you 
choose, the more the camera will cost. Here are some examples: 

 
• black and white – This mode lets you shoot you 

photos in black and white, simulating black and 
white film. If you have software like Photoshop 
Elements, you can convert a color photo to black 
and white, giving you two options for one photo.  

• sepia tone – If you like old photos in black, white 
and sepia tones, this would be a fun option for 

your new camera. 
• custom color modes allows you to setup your camera with special color choices 

so skin tones, unusual lighting, etc. will not be corrected by the camera giving 
you an image that is true to what you see through the lens. 

• fireworks or night scenes – If you enjoy night photography of cityscapes, 
fireworks, or any other scene with high contrast of light vs. dark, this is a good 
option to look. 
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• snow or beach mode for very bright backgrounds. 



 
 
 
Photo enhancement: Certain models give you the option of cropping and removing 
red-eye while your photos are still on your camera. 
The control of these options take place using the LCD 
screen.   
 

 
 
 
Video mode: This varies from camera to 
camera. Some shoot short video and a few will 
shoot video for up to an hour, according to the 
maximum space available on your memory 
card. Not all have sound capability. 
 

 
 
PictBridge Technology This feature allows you 
to print from your camera to a printer without the aid 
of a computer.  You must have a printer that is 
PictBridge compatible.  The feature is more common 
on small photo printers such as the Epson 
Picturemate (see printers). Once a PictBridge digital 
camera is connected to the proper printer, print 
options appear on the camera monitor (LCD). The 

camera menu system is used to make settings such as print size, layout, media type 
and date. Sometimes the compatible printer will have it’s own LCD screen so you can 
make your choices using the printer screen and buttons instead. 
 
Optical Zoom vs. Digital Zoom 

©Ann Arbor District Library 3

Optical zoom is similar to what you'll find in a regular 35mm 
camera: When you push the button to zoom in or out, physical 
lens elements move inside the camera, to achieve the desired 
effect. Digital zoom has no moving parts. Using the processor 
inside the camera focuses on the object or objects already 
zoomed in on and digitally zooms in even more. The average 

digital camera has the ability to zoom in 3 or 4 times more than the maximum of the 
optical zoom. 



The problem with digital zoom is that you lose quality when you do this -- your images 
will tend to be more "pixilated" than the same image taken with an optical zoom camera. 
This is due to the "interpolation" the camera uses, which is a nice way of saying that it 
makes a guess about how the picture should look while zoomed in. Having optical AND 
digital zoom on a camera isn't bad, but I'd try to avoid cameras with only digital zoom, 
myself. 

Kodak has come out with a new camera with two 
separate lenses you can switch between depending 
upon your needs. One is a macro or close-lens and 
the other is a standard lens with limited zoom. It’s an 
interesting solution for people who like to do close-
ups but prefer a small camera. 

 
Resolution of the photos you are taking. 
 
Every camera has a maximum number of mega pixels it can produce 
when recording a photo file.  That’s why cameras are referred to as a 6, 7 
or 8 mega pixel camera.  Your camera will take photos in various sizes 
such as small, medium, large and maximum. Depending upon the 
capability of your camera, the sizes could be equal to 640 x 480 pixels for 
a small or low-resolution photo; 1600 x 1200 pixels for a medium photo, 2048 x 1636 
pixels for a large photo file. You set the size of the photo in the camera’s menu. 
 
Larger photo files are good for printing 5” x 
7” or 8”x10” photos. A medium sized file 
will print a nice 4”x6” photo. The larger the 
file size the more pixels you have to play 
with if you want to alter the photo by 
cropping. You can cut down or crop a 
large file and still have enough pixels to 
print a good 4” x 6” photo. 
 
Downloading images 
 
There are two ways to get the photos from the camera to your computer.  
• One: you can connect your camera to your computer via a cable which came with 

the camera. The cable plugs into the camera and into a USB port on the back or 
front of your computer, depending on the computer. 

• Two: Take the camera’s memory card and 
insert it in a media reader connected to your 
computer.   
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Before we move on, lets talk about media card readers. These inexpensive accessories 
can save you a great deal of time and are easy to use. They connect to your computer 
either in the back or in the front, depending upon your machine.  Most come with a 
variety of slot sizes so as many as twelve different types and sizes of media cards will fit 
in them. These readers usually cost less than $30 and can be found in many stores 
including office supply stores, electronics stores, etc. 
 
If you’re using a Mac, iPhoto may pop up and automatically copy the photos for you.  If 
not, once you’re done, another drive should show up on your computer’s desktop. 
Double click this drive to open it and you’ll find a DCIM directory on the camera card, 
which actually contains your photos. 
 

 
 

So double click that DCIM folder as well.   
 

 
 

When putting digital photos onto a Windows based computer, a Device Detected 
options box may pop up after you either put a memory card in the card reader or 
connect your camera to the computer via a cable.  

• Select either  
o Organize and edit using Adobe 

Photoshop Elements or  
o Copy pictures to a folder on my 

computer.   
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If you decide to use Photoshop Elements to organize 
your photos, click OK and Photoshop Elements 
Organizer will open. Organizer helps you create 
collections of photos so you can find them easily.  



• In the Organizer window, click on the camera icon below the menu bar.  
• From the dropdown menu, select downloading from the camera or card 

reader. 
• Click Get Photos 
• Next choose a folder on your hard drive in which to download your photos 

and press OK. It will take a few minutes to download your files, depending on 
the number and size of the images you are downloading. 

 
 
 
 
Now you see a list of your photos.  
 
Copy these to whatever folder you 
like on your computer.  On a Mac, 
you could add them to your 
Pictures directory if you like. 
 
 
Here I’ve selected the Pictures directory and 
created a new folder for my pictures. 
 
 
 
 
 
 
 
 
 
 
 
 
Resizing images 
 
Now that your photos are in the folder 
in your computer, let’s open Photoshop 
Elements and work on one of the 
pictures.  Go to File and from the 
dropdown menu, choose Open.  
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The Open dialogue box will 
appear. Find the folder in your 
computer, which contains the image 
you want to view. Select the file and 
press the Open button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The photo you have chosen will appear in the work area of your Photoshop Elements 
screen. Now you can edit, rename or simply get a more detailed view of the photo you 
took. 
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Becoming familiar with the Photoshop Elements work area 
 
When you open Photoshop Elements 4, you will find six important areas that you will 
need to be familiar with both in class and when using Photoshop Elements at home. 
 

 
 
Across the top of your page you will see a list running from left to right. This is called the 
Menu Bar. This bar contains menus for performing tasks. The menus are organized by 
topic such as files, editing, enhancing images, etc. When you click on one of these 
topics, a drop-down menu will appear so you can choose options related to that topic. 
For instance, when you click on File, the drop down menu that appears contains options 
such as open, save, save as, etc. for working with files.  
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Below the Menu Bar is the Shortcuts Bar. This bar contains buttons you can press 
instead of going through the menu bar to execute commands such as save, open a file, 
create a new file, undo, etc.  You can also find these options by going to the Menu Bar 
and then to a specific title but this is a faster way to do the same thing.  For example, to 



save a change in our file, you can either press the save button on the Shortcuts Bar or 
go to File and from the dropdown menu choose save. 
 
 

 
 
The Options Bar is below the Shortcuts bar. This bar contains options for using 
whichever tool you have selected for working on your photo. Each tool has a different 
set of options on this bar. 
 
 
 

 
 
The Active Image Area is the part of the screen where you image will be when you are 
working on it. It is immediately below the Options Bar. You can have several images 
open in this area at the same time. 
 
 
 
 
The Toolbox contains tools for editing, selecting and viewing your images as well as 

tools fro painting, drawing, and creating type.  It is on the left side of your 
screen. It can be moved to other parts of the active image area is needed. In the 
toolbox you will find the Marquee tool, the lasso, the magic wand, a cropping 
tool, custom shape tool, etc. Any tool icon that has a triangle in the corner of 
that box has additional tools underneath it. You can access them by clicking on 
the triangle.  
 
The Palette Bin is located in the upper right corner of 
your screen. It contains the How To, Styles and Effects, 
and Layers palettes. The How To section gives you 
helpful hints on how to complete many tasks and creative 
things to do with your images. Palettes help you modify 
images and the Palette Bin helps you organize the eight 
palettes that Photoshop Elements offers you. One of the 
palettes is a Navigator window for enlarging and 
shrinking the image inside the work area. There is also a 
color palette for changing the color of selected portions 
of your image, type, etc.   
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Saving a file 
 
When you’re done working on your image, you need to save it. It is best not to save 
changes to the original file. Give the updated file a new name or add a number, letter, 
etc. to the original name so you know it has been altered.   
 
There are a couple of things to talk about first.  If you’re sure you aren’t going to do any 
more editing of this photograph, you can save to a JPEG format, which can be easily 
placed on a web page or email.  This provides a high level of compression to make sure 
your picture takes a small amount of space.  Unfortunately, this compression also 
introduces some artifacts that you normally can’t see, but if you were to edit and save 
and edit and save several times in the JPEG format, you would eventually see very 
large blurring and blocking in your photos.  So if you know you’re going to be working on 
this photograph some more, please choose the PSD (PhotoShop Document) format, 
which takes a lot of space, but makes a perfect copy with extra information that makes it 
easier to work with the advanced features of Photoshop and Photoshop Elements. 
 

To save a file, go to File on the 
menu bar and from the drop down 
menu, choose Save As. The Save 
As dialogue box will appear and 
give you a choice of places on your 
hard drive to save this file. Go to the 
box near the bottom of the box and 
type a new or altered name for 
your image.  Now choose the type 
of file you want the file saved as 
from the drop down menu. 
 

 
Press Save.  
 
Another window will appear with settings for 
the quality of the image. You can choose 
small, medium, large or maximum from the 
drop-down menu or use the slider to choose 1 
to 10 for file quality. Staying the medium 
range is safe unless you are working with an 
image that will be printed at 8” x 10” or larger. 
Then it can be saved at a higher quality.  
 
Press Save  
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Resizing Images 
 
In the drop-down menu under Image, choose 
Resize. 
 
Within the Resize menu choose Image Size.  The 
Image Size dialogue box will appear. In this box 
you can change the size of your image using 
different kinds of measurements such as inches, 
pixels, and points. As long as the Resample Image 
box is checked at the bottom of the window, the 
image will remain in proportion when you change 
one of the dimensions. The standard number of 
pixels or dots per inch for web images is 72. Color 
ink jet printers will need at least 150 dots per inch. High-resolution images printed on 
photo printers will require a resolution between 150 and 300 dots per inch. When you 
have adjusted the size of the image to fit your needs, press OK.         
 
Tools 
 
On the left side of your screen, you will find a box with tools used for selecting, editing 
and viewing your images as well as painting, drawing, and creating type. When you 
place your curser over one of these tools, a text box will pop up giving you the name of 
the tool. This is called a tool tip. There are additional tools hidden behind the tools that 
have a triangle in the lower right hand corner of the square the tool is in. 
 
Cropping an image 
 
Cropping is the process of selecting a portion of an image you like and deleting the part 
you don’t want to keep.  
 

• To crop an image, choose the Marquee Tool from the toolbox and click on it. 
Note that there is a square 
marquee tool and an elliptical 
marquee tool. Let’s start with 
the square one. Your curser 
is now the Marquee tool.  
 

Place your curser in the upper left corner of the area you want to keep and press down 
on your mouse button. 
 
 
 

©Ann Arbor District Library 11

 



 
 

 
 

• Drag the curser diagonally across the area until you have framed the part of the 
photo you want to keep.    

 
• Release your mouse button. There should be a moving rectangle or marquee 

surrounding the section you have selected. You can move 
the marquee to another place on the photo by putting your 
curser on it and moving it using your mouse. If you want 
to make the marquee larger or smaller, place your curser 
outside of the box and click. This will cancel the marquee 
box and you can make the marquee again at the new 
size. 
 

• Choose Image and from the drop down menu choose 
Crop. The area outside the marquee now will disappear 
leaving your newly cropped image. 
 

To enlarge the newly cropped image, select the zoom tool. Your curser will 
turn into a magnifying glass. When you click on the image with your mouse, it 
will enlarge. 

 
 
When the zoom tool is selected, the Options Bar will have a picture of the zoom tool in 
the left corner. You can magnify the image using the bar the following ways: 
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o Click on the magnifying glass with the + for magnifying and – for reducing 
the image. 

 
 

o The Zoom percentage box can be used two ways: type in the percentage 
number you want the image to be shown or press the arrow and a slide 
will appear which you can adjust for the percentage. 

o If you press the Actual Pixels button, then the image will appear on your 
screen at its actual size.  

o Fit Screen will make the image fit inside the available work area. 
o Print Size will show you the image at the size it will be when printed. 

 
• If you are happy with the image and have no further changes, then save it with a 

new name or the original name plus a number or other indication that this is a 
changed file (File > Save as). 

 
Color and contrast 
 
One of the many options given to digital camera owners is the ability to correct color, 
contrast, and red eye (eyes that appear red in your photos after using a flash to take 
your photo). Here are some ways to correct those problems or simply to adjust photos 
that you aren’t quite satisfied with. 
 
In the drop-down menu under Enhance you will find a number of easy options for 
making corrections to your photos. Auto Smart Fix automatically adjusts the whole 
color balance of the photograph and enhances details in the shadows and highlights of 
your photograph.  It’s a good place to start with working on your photos. Choose Auto 
Smart Fix and see if you like the change it makes to your photo. If you don’t like the 
change, either choose the Back button on your tool bar (below File) or choose Edit 
and Undo. 
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Other choices for 
simple adjustments 
under Enhance include 
Auto Levels, Auto 
Contrast, Auto Color 
Correction, and Auto 
Red Eye Fix. Like Auto 
Smart Fix, you simply 
choose the 
enhancement option 
and the software 
decides how much or 
little to enhance your 
photo. If you want to 
have some control over 
the changes being made, then try Adjust Smart Fix, Adjust Lighting or Adjust Color. 



Each option gives you a before and after view of the image so you can see how much 
change there will be to your photo. 
 
Email 
  
It’s advisable to make smaller versions of the photos you want to email and 
rename them. Sending a photo in its original size could mean you are sending an 
image that is two or three times larger than your computer monitor and would be difficult 
to view. The person receiving your email would have to scroll back and forth several 
times to try to view the entire image.   
 
Also, the original image most likely is a large file. It will take a very long time and receive 
via email unless you and your recipient have a high speed internet connection. So, 
reducing your image in size to reduce the file is also a very good idea. Also, a large 
email attachment may be too big for your friend’s mailbox and your email may bounce 
back. 
 
Rename the image after it’s been reduced in size for emailing purposes. Never 
alter your original image and save over it! You cannot go back after saving! 
 
An average computer monitor is 800 pixels wide and 600 pixels 
high so resize your image to fit in that space. Open your 
original photo. Go to Image > Resize > Image size. This box 
will come up. Make sure the boxes at the bottom for Constrain 
Proportions and Resample Image are checked.  You can see 
under Document Size that the image is currently over 48” wide 
and 32” high.  
 
In the Pixel Dimensions section in the Width box, type 800. 
Now the dimensions of the image change but stay in proportion 
so the photo won’t be distorted.  
 
Now your image is 800 pixels wide and 533 pixels tall. It should 
fit on a computer screen at actual size without a problem. Click 
Okay.  
 
Now save the image with a new name. Go to File > Save As 
and in the box rename the file in whatever way is best for you 

to remember what the image is and 
that it’s smaller than the original. 
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Next the Jpeg Options box will appear.  In the Quality box, 
choose a mid-range number such as 5 or 6.  For Format Options 
make sure you’ve checked Baseline. In the Size box, you can 
check to see how long it will take to send this image as an email 
attachment depending upon your internet connection.  You can 
see in the first example, this attachment will take half a second 
to send via high speed internet. In the second box, you will find 
that the same photo when sent by modem will take 15 seconds. 
If the amount of time to send the image seems right, then click OK.   
 
Sharing your printed photos 
 
Like film cameras, you can still get your photos printed at the local camera shop or drug 
store.  Instead of removing a roll of exposed film from your camera, you take the 
memory card out and give it to the clerk at the store. Just remember which photos on 
the card you want printed.  

 
Photo kiosks    
If you want to print your photos more quickly, then you have several 
options including the use of photo kiosks which can be found in 
photo processing stores such as Ritz Camera, drug stores, etc. Bring 
the photos you want to print saved on your camera card and insert 
the card in the slot in the kiosk. Then you choose the photos you 
want to print and the print size. The cost per print varies from store to 
store and according to size. 
 

Home photo printers        
Companies who make traditional desktop printers have made photo printing more 
affordable and popular by creating these fun and fast photo printers you can either 
connect to your computer directly to your camera.  Some will only print on 4” x 6” photo 
paper and some print on 4”x6”, 5”x 7”, and 8.5” x 11” photo paper.  
 
The printer companies quite often make two or three models of their brand machine, 
each with a different set of options. For example, there is a basic model which prints 
either from your computer or your camera. There is an intermediate model which comes 
with it’s own LCD screen so you can do simple editing with the printer and then print.  
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There may also be a third model with 
has even more options such as a 
battery or a cord to hook it up to your 
car cigarette lighter outlet to make the 
machine portable. This third version is 
sometimes referred to as the party 
model because you can take photos 
of your party and make prints for your 
guest before they leave. 
 
 
 
 

 
Most home photo printers range in price from $80 to $200. You should compare the 
cost of each print too before making your purchase. The price of supplies varies from 
company to company. 

The Epson Picturemate (left) is known as a party printer. It has the 
option of using a special battery so you can take it anywhere and print 
photos for your friends and family as soon as you take them. It is light 
weight and has a convenient handle. 
  
Kodak has their EASYSHARE system which 
makes printing at home very easy. A number 
of their cameras have EASYSHARE 

capability so you can put the camera on a dock on top of the 
printer, choose the photos you want to print and watch each of 
them be printed in 60 to 90 seconds. This line of printer will 
print only on 4” x 6” sheet but you have printing options of 
creating four different sizes of prints on a sheet. There are 
other options available such as wireless printing, red-eye 
reduction, automatic color correction, and the ability to print 
with or without a computer. 
 
Paper 
 
There are a variety of photo papers available to the home photo printing public. Major 
brands are Kodak, Canon, Epson and HP.  When choosing paper, think about how you 
are going to use the photos. 
 
Types of paper: uncoated, coated, matt, glossy 
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Uncoated paper such as plain paper you find in copying machines or for general printing 
in your printer is good for printing a web paper or a report but not for photos. The ink is 
absorbed in the paper and spreads across the surface like water being absorbed by a 



sponge. The image becomes fuzzy. Coated paper gives the ink a surface to sit on and 
will give you a much sharper image. This paper is usually 20 – 24 lb or the thickness of 
paper you get from a copying machine. If you try to print on both sides of a sheet, it will 
show through. 
 
There is also presentation or imaging paper which is great for 
reports. It is 35 – 45 lbs. so it’s thick enough to be printed on both 
sides and it is coated so the ink won’t spread. Sometimes this 
paper also is acid-free so if you want to print a something special 
that you want the colors to remain bright for a long time, then 
using an acid-free paper should be considered. 
 
Matt or non-glossy photo paper will give you a photo with a soft overall finish. The paper 
was made for photographs and is feels like the paper used by professional photo 
printing labs. Glossy paper has a shiny surface. Again, the paper ranges in weight, 
depending upon the company.  The companies may designate their papers for everyday 
photos, better quality for framed photos and premium quality for special photos you 
want to last for many years such as graduation or wedding photos. 
 
Paper Sizes 
Photo paper comes in many sizes including 4” x 6”, 5” x 7”, and 8.5” x 11”.  The 4” x 6” 
and 8.5” x 11” sheets tend to come in both small packages of about 20 sheets and also 
a larger, more economical package of 50 to 100 sheets. 
 
There are some photo printers that only print 4” x 6” paper which 
give you the option of buying a kit with both paper and toner. This 
is because the toner package using will print only the number of 
sheets in the kit so the company is trying to make it easier for their 
consumers to pick up everything they need in one package. The 
cost is usually less too. 
 
Hint:  When printing photos, remember to tell your printer what kind of paper you are 

using. You will find this option in your printer 
dialogue box when you are preparing to print. 
Sometimes printers will even give you the option of 
choosing the brand of the paper you are using. 
Doing this will allow you to choose the quality of the 
paper and telling the printer how much ink to put on 
the paper so your photo won’t be covered with a 
puddle of ink.  
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Books and magazines available at the Library 
 
I Just Bought a Digital Camera, Now What?!  by Dave Johnson. 
How To Do Everything With Your Digital Camera by Dave Johnson. 
Digital Photography 1, 2, 3: Taking and Printing Great Pictures by Rob Sheppard. 
The Joy of Digital Photography by Jeff Wignall. 
Digital Photography: An Introduction by Tom Ang. 
 
PCphoto  
Popular Photography and Imaging   
Digital Photographer  
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